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The operating parameters of S-Link compatible programmable servos can be
changed by using this S-Link program. However, this software is used in the
state in which the computer and servos were connected by using the separately
sold ClIU-2 USB adapter, servo battery, and PC-Link adapter (or S-BUS hub).

*Note: The S-Link program is for Windows7/Vista/XP use and is not

compatible with other OS.

*Note: This S-Link program is not compatible with the S907*SB Series and

S3171SB.

S-Link program download and ZIP file extraction...............
S-Link program installation .............cccccoovviieviiiie e,
S-Link program removal (uninstall) ...........ccccooiiiiiinnnnn,
How to use the S-Link program ..........cccccvvvvivevieiie e,
Parameters setup screen Operation ............ccocvevvceverereeeennnns
Description of function of each parameter.............ccccooen....

OB MEBNUS ...t

Distribution & exemption of liability

e Futaba Corporation shall not be responsible for any damage caused by use of this software without

regard to legal foundation. Use this software based on agreement to this.

* The copyright of this software and document resides with Futaba Corporation. Redistribution without

the approval of the copyright holder is prohibited.

* Reverse engineering and modification of this software is strictly prohibited.
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The downloaded S-Link_En_V1001 file is a Zip format file. Extract (decompress) this
file.

1. With Windows Vista/XP, double click file S-Link_En_V1001 to display its contents.
2. Click "Extract all files". The Extraction Wizard launches.

3. Extract (decompress) Zip file S-Link_En_V1001 to the same location as the Zip
file storage location.

*Example: For Windows XP

M S-Link_Setup_En_V1001

Fil=  Edit View Faworites Tools Help

OBack L) L’i pSearch u—:‘ Folders -

Address |[B CiDocuments and SettingsiUseriDeskioplS-Link_Setup_En_v1001.zip

(]

Folder Tasks ES

[E] Extract &l files .

Other Placgs

@ Desktog
) Shared Racumes

ld Iy Metwork Places

1) »

Double click Zip file "S-Link_En_V1001".

S-Link_Setup_
En_¥1001

Click "Extract all files". ]

Extraction Wizard

Select a Destination ——
Files inside the ZIP archive wil be extracted ta the location you

Extraction Wizard

Welcome to the
Compressed (zipped)
Folders Extraction
Wizard

The extraction wizard helpz vou copy files
from inside a ZIP archive.

choose:

Select a folder to extract files to.

Filez will be extracted to this directory:
Erowvse...

Confirm the extraction destination.
(Zip file S-Link_En_V1001 save location.) | ]

Click the "Next".

< Back [ < Back ”L Mext > JI[ Cancel ]

, ((ctick the "Next".)

Extraction Wizard

Extraction Complete e
Files have been successiully extracted from the ZIP archive

Files have been successfully extracted to the following
directony:

C:\Documents and Set...\S5-Link_Setup_ En_%1001

To see your extracted files, check the box below:
Show extracted files

Press finish to continue.

.[Click the "Finish".

Cancel

< Back
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*Example: For Windows 7 or Windows Vista

Click "Extract all files".

L Jie) | i » S-Link Sftup_En V1001 »

Extract all files

Organize -

T.:i‘ Favorites Name

B Desktop . S-Link_Setup_En_V1001

»

Double click Zip file "S-Link_En_V1001".

k_—) | 1) Extract Compressed (Zipped) Folders

Select a Destination and Extract Files

Files will be extracted to this folder:

C:\Users\meigi.Futaba-PC\Desktop\5-Link Setup En V1001 | Browse...

Show extracted files when complete

Confirm the extraction destination.
(Zip file S-Link_En_V1001 save location.)

[Click the "Extract".]

e

Let’s confirm the extracted (decompressed) file.

1. At the end of extraction (decompression), a folder named S-Link_En_V1001 like
that shown below is created.

2. Double click "S-Link_En_V1001". The contents of the folder are displayed.

*Example: For Windows XP *Example: For Windows 7
or Windows Vista
J Jl
S-Link_Setup_En_¥1001 S-Link_Setup_En_¥1001
4 2
— |
D
g
- ’ Y
setup 5-LinkSetup-en
\. J
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Before installing the S-Link program, confirm that all other applications are closed.
Close all virus check and other resident programs, if any.

This program needs Microsoft .NET Framewowk 3.5.

If .NET Framework 3.5 is not installed in your computer, it is downloaded and installed
from the Internet automatically.

Please note: your computer must be connected to the Internet.

1. Select and double click the folder named
S-Link_En_V1001 created by downloaded = |
Zip file extraction (decompression). The @ ST
contents of the folder are displayed.

2. Double click the EXE file named "setup".

setup S-LinkSetup-en

T S-Link Setup

For the following components:

_MET Framework 3.5
3. |f ".NET Framefoer 35 Setup" WindOW F'Iea&ereactltl??gollowingIic:etnseagreement. Fress the page down key to
. 2ee [he rest ol 2 JgQreement.

appears, click "Accept".

.NET Frameforwk 3.5 is downloaded and . ]

installed from the Internet automatically. MICROSOFT .NET FRAMEWORK
3.5 FOR MICROSOFT WINDOWS
OPERATING SYSTEM

@ | Wiew ELILA for printing

Do you accept the terms of the pending Licenze Agreement?

If you choose Don't Accept, install will close. Toinstall vou must accept
thiz agreement.

[Clickthe "Accept” ]——)[[ Accept ]]L Don't Accept J

4. After "Welcome the S-Link Setup Wizard" window appears, click "Next".

rg! S-Link =

Welcome 1o the S-Link Setup Wizard

The installer will guide you through the steps required ta install 5-Link on youwr computer.

WARMIMNG: This computer program is protected by copyright law and international treaties.
Unauthorized duplication ar distribution of this program, or any partion of it, may iesult in severe civi
ar criminal penalties, and will be prosecuted to the maximum extent possible under the law.

— aw |<«—— Click the "Next" |
e ————————————————————
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5. Chosen to install this program for "Just me", or for "Everyone". Confirm the
program folder (save destination) at "Folder:" and click "Next". To change the

directory, click "Browse..." and

specify the folder which is to [ #sun

save the program and then
click "Next".

Select Installation Folder Q

The installer will instal

Confirm the program save folder at "Folder:". To
change the save destination, click "Brewse..." and
specify the folder which is to save the program.

To instal in this folder

Folder:

C¥Program Files (xB6)¥Futaba¥3-Link¥ [ Browsze... |

Inztall 5-Link for vourzelf, or for anyone who uzes this computer:

Y

() Everyone

@ Just me

or for "Everyone".

Chosen to install this program for "Just me",

Cancel ] I < Back ] [ Mext » ]

[Click the"Next" ]

6. After "Confirm Installation" window appears, click "Next".

i
) s-Link

Confirm Installation

Click "Mext" to start the installation.

The installer iz ready to install S-Link on your computer.

Cancel I

sk | e ) <—[CIickthe"Next"]

7. After "Installation Complete" is displayed, click "Close".

The above completes S-Link program installation.

”
i 5-Link

Installation Complete

5-Link has been successfully installed.

Click "Close" to exit.

Please use Windows Update to check for any critical updates ta the MET Framework.

Cancel

< Back <—[Clickthe "Close"]
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*Example: For Windows XP
To remove (uninstall) the S-Link program from the computer, use the Windows "Add/
Remove Programs" function. Since the operation method differs with the OS used,
refer to Windows help, etc.

1. Open "Control Panel" from the "Start" button at the bottom right side of the
Windows XP desktop.

2. Launch "Add/Remove Programs" from the opened "Control Panel".

3. After "Add/Remove Programs" is displayed, select "S-Link" and click the "Change/
Remove" .

% Add or Remove Programs

A
% Currently installed programs: [] show updates Sork by
Change or
Remove
Prograrms

Add Mew

B To change this program of remave it from yaur compuker, click Change o Remave,

P == —
Ej ‘I i & - [Click the "Remove". ]—T

AddiRemowve

4. "Are you sure you want to completely remove S-Link and all of its components?" is
displayed. Click the "Yes".

Add or Remove Programs

% ? J Are wou sure wou wWant to remoye S-Link From wour computer?

L fes J [ Mo ]

T—[cuck the "Yes". ]

5. This completes removal (uninstall) of the S-Link program.

*Example: For Windows 7 or Windows Vista

1. Select and double click the folder named S-Link_En_V1001 created by
downloaded Zip file extraction (decompression). The contents of the folder are
displayed.

2. Double click the EXE file named "S-LinkSetup-en".

setup S-Link5etup-en
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3. After the "Welcome to the S-Link Setup Wizard" window opens, select "Remove

S-Link" and click "Finish".

P
) S-Link

Welcome to the 5-Link Setup Wizard

() Repair S-Link

@) Remaove S-Link

[Click the "Remove S-Link". ]

Select whether vou want to repair ar remaove S-Link.

Cancel

J |

< Back

Finigh

2N
[Eck the "Finish". ]

4. After the "Removing S-Link" window opens and the "Installation Complete" screen
appears, click "Close". This completes S-Link program removal (uninstall).

'ﬁ! S-Link

Removing S-Link

S-Link iz being removed.

Flease wait...

(

Cancel

] |

-
15 5-Link

Installation Complete

S-Link has been successfully removed.

Click "Close’ ta exit.

Cancel

< Back

I

Cloze

| ||| «—{ ciick the "Close". ]

e ——————————————————————
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*Installing the CIU-2 device driver
A ClU-2 USB adapter is necessary to execute this software. Before using this software,
please install the CIU-2 device driver. If the CIU-2 USB device driver has already been

installed, advance to the next step.
*The CIU-2 device driver is available at the download corner of your Futaba impoter's home page.

*ClU-2 and servo connection

1. Connect the CIU-2 to the USB port of the
computer to be used. The CIU-2 LED lights green. ﬁ

(to Servo's battery)

2. Connect the PC link adapter or S.BUS hub to
the CIU-2.

3. Connect the servo to the PC link adapter or
S.BUS hub. PC link adapter (or S.BUS)

Programmable servo

4. Finally, connect in battery order.

|| 1]
Note: When connecting and setting another servo disconnect the
battery with the CIU-2 inserted at the USB port of the computer, =~ Connect to a computer USB port
connect the next servo, and then reconnect the battery.

*Starting the S-Link program =
1. In the state in which the servo was connected to a computer by the
previously described connection method, double-click the "S-Link ¢ .= fCHEE s
_ -Link Shortcut an
Shortcut" icon. icon

2. The parameters setup screen shown below appears and the CIU-2
lamp of the screen lights green.

A

i CIU-2 lamp of the
T screen lights green

*When the CIU-2 lamp of the screen did not light green and the following message
was displayed the ClU-2 is not properly connected to the computer. Click "OK" and
check the connection.

The CIU-2 is found. =5

Cannot find the CIU-2,
So, it is impossible to communicate to the servo.
Please check the connection of the CIU-2 to the computer.




*Connecting the S-Link program and servo

S-Link

When connecting and setting 1 servo as shown in the preceding figure, automatically
display the ID and current setup parameters of that servo by clicking the "Connect"
button or selecting "Connect" from the "Tool" menu. The Servo lamp on the screen

lights green.
[7]ID Enable sagsz
B2 Seree

iGH Change

Dead Band

vl
oY O
-
~ -

[Automatically display the ID.]—

l Gonhect |

-
[# s-Link 1.001

; & Dizcfonect
[Click the "Connect". ]—T

File(F)

ool | Helabn

| Connect

DTSCOTELE

Write
Default

Language 3

Settings
% 9

Y

1D Enable

Dead Band

vl
e I

SBUs2
L]

CIL-2 Servo

Co*@t

I
bttt

The Servo lamp on the
screen lights green.

’f
o - i ite:
1520 = i
e (b2

When connecting multiple servos simultaneously using a S.BUS hub tick the check
box at the left side of "ID Enable", input the ID of the servo you want to set, and click
the "Connect" button. The current setup parameters of that servo are displayed and the
Servo lamp on the screen lights green.

:[Tick “ID Enable" and input servo ID. ]

= e
Y
1D Enable 5 BgSQ
015 | | oouo! CIU-2 Servo
iCGH Change .
.
Dead Band [# s-Link 1.001
Connect
Ry File(F) | Toal | Helots

-
~ -

& Dizcolinect
[Click the "Connect". ]j

| Connect

DT

Write
Default

Language r

Settings
% 9

1D Enable
0001

Dead Band

vy
e S

SBUs2
L]

CIU-2 Servo

Cor*ct

]
LR

-
,

The Servo lamp on the
screen lights green.

3
N -

1520 |= : Yl ite
g mmttin |[]

When the Servo lamp on the screen did not light green and the following message was
displayed, click "OK" and check the following:

-

Error message.An error is detected.

SS5)

Communication error.

ID will be different or the servo may not be connected.

* Servo firmly connected?
e A battery with sufficient capacity connected?
¢ In the state in which "ID Enable" is ticked, does the manually input ID and the displayed ID

match the connected servo? (When 1 servo is connected, untick “ID Enable")
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*Setting and adjusting the parameters
Each parameter is adjusted.
* Refer to "Description of parameters" (P15) for a description of the contents and the method
of operating each parameter.
*Writing the setup parameters and initializing the servo

1. Write the set contents to the servo by clicking the "Write" button. The set contents
can also be written to the servo with "Write" of the "Tool" menu.

”
— [BA s-Link 1001
FilelF) | Tool(T) | Helpith
i 1D Enable s EgSE Connect
20 . Disconnect
% [[o7a ] (o000t | EE Son I _
% " m ) i‘ Write
. % [Cllck the "Writre". ®
2 :
Z. 3 DT _
Cinect Language s
2 ot Vi ',
e K LT
- p i o e
= = | -
' 5 e : -y B
= P ’.
g = dee
Nefault

When writing of the setup parameters ends normally the message "Succeeded in the
data writing." shown below (left side) is displayed. End writing by clicking "OK". If the
message "Failed in the writing data."

shown below (right side) is displayed, click "OK" and check the following:
* Servo is firmly connected?
 Battery with sufficient capacity is connected?

Application status. ﬂ Error message.An error is detect..‘g
. ._
0 Succeeded in the data writing. F l: Failed in writing data.

To return the contents set in the servo to the factory setting initialize the servo by
clicking the "Default" button. The setup contents of the servo can also be initialized
with "Default" from the "Tool" menu.

== (@ s-tink 1001
File(F) | Tool(T) | Help(H)
10 ID Enable 5 EgSQ | Connect
<0 % T8 S ,;V‘I_r‘ Disconnect

Y .
4 5BUS OH [ 01 ] [ Chanes | ¢ e (e L
% I E

% Dead Band

o
\‘ ,f

i v Settings
R - -
) = =

] v
|

| Click the "Default". [000 | dee
B L x =T .

0
ozition

Corinect Language ¥

~00 =80 -gf
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* To initialize the servo, its ID must be valid. When a servo whose ID was automatically
recognized at independent servo setting is initialized an ID Warning message is displayed.

Click "OK" and then disconnect the S-Link program and servo by clicking the “Disconnect”
button. After ticking the check box at the left side of the “ID Enable” and reconnecting the
S-Link program and servo, "Default" is executed.

-
Warning!! M

flé This function is not available to use when the servo ID is NOT set.

When initialize is executed, the confirmation message shown below is displayed. Click "OK".

»
Initializing. . =5

I@ The parameters of the servo is returned to the initial settings. OK?

When initialization ends normally the message “Succeeded.” shown below (left side) is
displayed. End by clicking the "OK" button. If the message "Connection error!" shown
at the below (right side) was displayed click "OK" and check the following:

* Servo is firmly connected?
* Battery with sufficient capacity is connected?

r r r
Please confirm again. M Error message.An error is dehect...ﬂ

e .
0 Succeeded. @ Connectien error!!
L ¥ g

2. Click the "Disconnect" button. Or select "Disconnect" from the "Tool" menu.

3. Remove the servo.

N\ -
C=0ee [ s-tink 1001
| File®) [ ToolT | HelpH)

0 ID Enable 55352 E—v—ﬁ w0l e
20 | Disconnect B
Wi, 2 — OL-2 Servo : AN
Il .,'u“., . Write i i
Default £ N
| Comﬁm | Language » 4 ¢
‘% ‘ | @, Settings
- [Comen B
i

> ' §
10 | dee 8 =

Note: Do not pull out the lead wire or turn off the power while parameters are being written.
Note: After the parameters are rewritten, check the operating direction, etc. by static test.
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*Saving setup parameters and reading saved setup parameters
The set contents can be saved and read only in the "Connect" state in which the servo

lamp is green.

Saving setup parameters to file

1. Select "Save" or "Save as" from the "File" menu.

(@l s-tink 1001 o
File{F) ToolT) Help(H)
[# 1D Enas SBUS2
1] 1 (1] 1 013 noon G2 Servo
NwlraIIOFfset 4 SBUS CH [[11 | [ Chares | ® o
. Dezd Band o
- = .‘? \\.“r?, L —
S <
g P = B
000 | deg 2 = <
2 e [ Wit ]
v ) L3
o 7
[ Dot |

* "Save" rewrites the currently displayed setup parameters.

'm S-Link 1.001

'm S-Link 1.001

File(F) | Tool(T} HelpH)

(RS II!
Save AslA)
Exit(X)

aseg [
S J

rvo Pasition

File(F) | Tool(T} HelpH)
T Opent®)
Save(S)

Save As(A)
Exit{X)

aseg [
S J

rvo Pasition

2. When creating a new file with "Save as" since a data save dialog box opens,
select the save location and save the setup date of the parameters setup screen

to the computer as a file by clicking "Save".
* However, S.BUS CH setting is not saved.

- =
[ Please select data save folder. g
OO’| .. » Libraries » Documents » S-Link v|$,|| Search S-Link pl
Organize ~ New folder fs -
5 Favorites — Documents library e by ¢ Faiies &
.} Desktop S-Link
iy Dovinicads 2 MName Date modified Type Size
“E Recent Places .
|| Futaba-01.fth 2012/05/14 13:32 FTB File 1KB «
4 Libraries
i=_=| Documents
J’ Music
[ Pictures
B videos =
\ ( . .
Filenar{e: Futaba-02ftb | | Decide the save location.
\
Save a5 type: | o-LINK File( kb) v
A Enter a name. [ e | |HEerme—t { Click "Save". '
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Reading saved setup parameters

1. Select "Open" from the "File" menu.

'ﬂ S-Link 1.001

Lt

€
£
5

2. When saved setup parameters are read since the message shown below, which
automatically transfers the contents to the servo, is displayed, to execute the read

command, click "OK".

-
Please confirm again.

==

OK to transfer the parameter?

[-”_""- The parameter data are automatically transferred to the servo after
L reading the file.

3. Display the setup data on the parameter setup screen and automatically transfer
its contents to the servo by selecting the save location at the data save dialog box

and clicking "Open".

However, to memorize that data at the servo, click the "Write" button of P10 and
write the data to the servo or execute "Write" from the "Tool" menu.

| Recent Places |z

s
! Please select the file. ﬂ
o
{ u\ I\ + Libraries » Documents b S-Link = |44 || searcn s-tink o]
Organize v New folder = O @
5 D ts lib
0 Favorites T ocuments library Arrangeby:  Folder ~
P Desktop S-Link
1 Downlosds Mare ° Date modified Size

2012/05/1413:32

1KB

|| Futaba-02.ftb

o3 Libraries

| 2012/05/1413:37

A

1KB

E-'] Documents

J5 Music

[E] Pictures

)

Click the read data.

Videos

#d Homegroup d

File name:  Futaba-02.ftb

[Select the save location. ]
v [s-uNkFilerae) S o

l Open Iv! [ Cancel ]

' Click "Open". '
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*Disconnecting the S-Link program and servo and ending the S-Link program
1. Disconnecting the S-Link program and servo

After the end of work and before turning off the servo power, terminate
communication by clicking the "Disconnect” button or by selecting "Disconnect"

from the "Tool" menu. The servo lamp goes off and the S-Link program and servo
are disconnected.

-
== [ s-Link 1.001
File(F) | Tool(T) ; HelpH)
ID Enable SEUS? —anedl
? 2 | Pscomnea | p0 0
W, e } : iy
i % Write
[ead Band T Language b
) Ui g 5
S G 0, Settings
i . g B
- 2 RN ey !
g % N A 000 | deg & = |
=z ”.r, .\‘\ y 2 = a
g Lo Is 8 5w = R I te ] B 1520 L
i 5 C
Click the "Disconnect". |- m 0
‘isltlnn Servn Poazrbion

2. Ending the S-Link program

To end the S-Link program, click "Exit" of the "File" menu.

(@ 5-Link 1001 [F=NEE)
File(F) | Tool(T) Help(H)
L] Open(0) , 1D Erste 2BUS?
H Save(S) 0 10 1o 2 . ; L ]
! ! » W % ) GIU-2 Serva
Save AstA) A N WIS ne T
= - ¥ ¢ ¢ SBUSCH[ 07 | [Chame
|——_I1 -

% Dead Band

2 : ‘? ( R LT
ST : ? :._" '.: Disconnect
000 | gog % = 7
E 1520 [0 x CE gy e | e
2 [086 | dee |
— [ petour |
Serve Position

oo ) [ 1990 1590 1830 | 2138

If the CIU-2 is disconnected from the computer USB port while the S-Link program
is starting, the message shown below is displayed. However, there is no special

problem with this confirmation message. Click "OK" and check the CIU-2 and
computer USB port connection.

i B
The CIU-2 was disconnected. ﬂ

The CIU-2 connection is lost.
Cannot communicate to the servo.

R
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*Parameter screen
The parameter screen has the following functions:

* There are some functions that cannot be used depending on the servo used. When a set
value is not appropriate oscillation may occur, but this is not a servo trouble. However,
connecting an oscillating servo may cause the motor to overheat and lead to trouble.

Immediately return the setting to its original value.

g - A
[l s-Link 1.001 L=l
File(F)  Tool(T) Help(H)
| ID Enable SBUs2
0 A0 0 19 2 = ®
2 -1 ? 1 . ™ £ 5) 4) CIL-2  Servo
6) Meutral Offzet : & SElEE
i $ S 2
& - 8) Dead Band = }
= = ) o | Gonnect 2
A ’ e
o :
i I -
dee B Aineleldez) =
3
= Sy ‘\‘
= el it J : Q)
' Des =
iy
() . Default 2 .'
Servo Position
[ g20 ][ 1220 | [ 1520 | [ 1820 | [ 2120 |
Reverse
Travel ajust 7) Damper factor —
Ll et . v, Right 0570805 UL 12) @ NormaI15
7 O < '"'W “ ‘.‘I"’,&Eﬁ i () Reversé
7 -__ : .._ eI \ A E E Stop Mode
‘- / \. J - =
(e T— h i 3 = 13) ~ - 9) - = () Free
9 e B S R, 3 6 = 16
% & | Yo ™ © Hold
Stretcher 2ain Eoost Bl
@ ON
|| Speed Contral Soft Start Boost 10) Smoother 18) 2 17
nu, 11) \\\lf/"14) ® 0N 1 oN @ OFF
Z 2 S B ® OFF @ OFF
w, | Futzlhha
'?f'i-"““'ﬂfs' [ 20 Jsec/bidee S-Link Ver 1001

Set values can be changed by clicking or dragging the dial and lever of each
parameter. In addition, after a dial or level is selected by clicking, operation by mouse

wheel and keyboard arrow keys is also possible.

1) "Servo position data display & setting" 11)
2) "Connect" button 12)
3) ‘"Disconnect" button 13)
4) "Connection status display" 14)
5) "ID.S.BUS CH setup" 15)
6) "Neutral Ofset" 16)
7) ‘"Travel Adjast" 17)
8) "Dead Band" 18)
9) "Boost" 19)
10) "Boost ON/OFF" 20)

"Speed Control"
"Damper factor"
"Stretcher gain"
"Soft Start "
"Reverse"

"Stop Mode"
"Buzzer"
"Smoother"
"Write" button
"Default" button
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Servo position information display and setting
This setting changes the servo position. Servo operation after a parameters change
can also be checked.

e . . I 140 0 19
l) Position information meter (angle) j 10 20
The meter needle displays the servo
position and is linked with the slider
position.

2) Position information PWM width (ps)

Displays the servo position by PWM width.
ﬂng[e(dai))

3) Position information Rate (%) - 3 = 4
. - 2 = o0 % =g )
Displays the servo position ' 2) 1S20 1520 f#
with the center as 0% and 60 (}5)
degrees as 100%. S60r0. POSHIEN. . ovvoveeerernnnn,
7) (920 ) (1220 ) (1520 ] (1820 ) (2120 ] :

4) Position change text box N s s e S e R s e
Displays the servo position by PWM width. The position can be changed with the up/down
buttons at the right.

5) Slider
When the slider is moved while clicking with the mouse, the servo operates over the
maximum left and right 600 range with the center as Odegrees.

6) Moving range
Displays the center position offset by neutral adjustment and the moving range by travel
adjustment.

7) Direct position setting

When the button designated PWM width is clicked, the servo moves to the specified PWM
width position.

"Connect" and "Disconnect" buttons l
Connect and disconnect communication between S-Link program 1)0':’"L

2f e ||

) "Connect" button

When the "Connect" button is pressed, the program communicates with the servo and reads
the parameters of that servo and displays them on the screen.

2) "Disconnect" button
When the "Disconnect" button is pressed, communication with the servo is disrupted. The
"Disconnect" button is ineffective if servo recognition by "Connect" is not successful.
Connection status display

Displays the CIU-2 and computer and S-Link program and servo
connection status.

1) ClIU-2 lamp SBUSY
When the CIU-2 is connected to the computer, this lamp lights green. ®3)
CIU-2 Servo

2) Servo lamp ‘ I‘
1)

When the servo was connected by “Connect” button, this lamp lights green. 2)

3) S.BUS2 lamp
When the connected servo is compatible with the S-BUS2 system this lamp lights green.

16
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ID. S.BUS CH (channel) setting

1) ID

S-Link

When connecting 1 servo to the CIU-2 untick the “ID Enable" check

box, then click the "Connect" button or select "Connect" from the "Tool"
menu. The parameters are read and the servo ID is displayed. The ID

[¥] ID Enable
1) 00001

cannot be changed. If the "ID Enable" check box is ticked, the Warning ﬂ ﬁ
message show below (left side) will be displayed. 5.BUS CGH Change

When connecting multiple servos to the CIU-2 tick the "ID Enable" check box, input the ID
No. of the ID seal attached to the servo whose parameters are to be read, and click the
"Connect" button or select "Connect" from the "Tool" menu. If the ID is a mismatch, the
Error message shown below (right side) will be displayed and communication will not be

established.

.
Warning!!

- oy r
ﬁ Error message.An error is detected.

oo |

J_!A ID-effective is OFF,

connected.

It is possible to connect ONLY one (1) servo when the setting of the

The communication is not established if the multiple servos are

Communication

ID will be different or the servo may not be connected.

Error.,

—

2) S.BUS CH (channel) (S.BUS servo only)
This is the channel assigned to the servo when used with the S.BUS system. Always assign
the channel before use. When the "Connect" button is clicked, the CH number of the servo is
displayed. CH assignment can be changed here.

3) "Change" button

_

This button is used with the S.BUS system and when changing the channel assigned to the

Servo.

How to change S.BUS CH (channel) change

SBUS CH (—[(1) Click "Change" ]

Changing the channel...

01

Changing the channel...

’ cancel

Lo |-

l (4) Click "OK" '

l e ” = ] (2) Click "v* '

Changing the channel... =
I3} -
=-CH -
- 01 =
4
03
- [T} |
L. 015
06 [(3) Double click "CH #" ]
il

-
Application status.

==

4 l: Succeeded in the channel data writing.

A

(5) Click "OK"

(6) A new number of "S.BUS
CH" is displayed.

*Only S.BUS CH (channel) setup is completed by clicking the "Write" button.
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S-Link

Neutral Offset

The neutral position can be changed. However, when the neutral position was changed
substantially, the servo throw may be exceeded at maximum travel and a dead band
within which the servo does not operate may be created.

(Setting range: -32.0deg to +31.75deg based on the default position)

) Set value change dial 3)
Changes the offset set value. AR SR

2) Set value numerical display Neutrallorrset
Displays the set value as a numerical value. A numerical value cannot ¢ \1')' 4. 8
be input. z g

3) Offset displays 2)%‘ de;4§ :

Displays the offset graphically.

4) Reset button
Returns to the set value written last.

Travel Adjast

The maximum left and right travels centered about the neutral position can be set
independently. (Setting range: 50% to 149.6%)

Travel ajust
) Left Travel adjustment set value change dial L i v\ s Rt
Changes the travel adjustment set value. - T W
2) Right Travel adjustment set value change dial " L ‘\14)” i ‘:4)
Changes the travel adjustment set value. | ‘””l-“_""g)ﬂfﬂ [

3) Set value numerical display

Displays the travel adjustment as a numerical value. A numerical value cannot be input.
4) Reset button

Returns to the set value written last.

Dead Band
The stop position dead band range (angle) can be set. (Setting range: 0.00deg to 3.98deg )

Relationship between dead band set value and servo operation

Dead band small : Stop position dead band width small. The servo immediately responds to
minute signal changes.

Dead band large :Stop position dead band width larg. The servo does not respond to
minutes signal changes.

Note: If the dead band width angle is too small, since the servo will operate continuously, the current
consumption will increase and the life of the servo will be shortened.

I) Set value change dial Dead Band

Changes the dead band set value. e

> Dl
2) Set value numerical display = =
Displays the dead band as a numerical value. A numerical value cannot & o 3)
be input. 2) 03 | ;eg

3) Reset button
Returns to the set value written last.



S-Link

Boost
The minimum boost applied to the internal motor when the servo is driven can be set.
(Setting range: 3% to 45%)

Since the motor is not started by the minimum boost, essentially it feels like the dead
band had widened.

Therefore, adjust the minimum boost at starting so that the motor immediately starts.

Relationship between boost set value and servo operation
Boost small : Corresponds to minute commands and operation becomes smooth.
Boost large : Initial response is good and output torque is large, but if too large, operation
becomes rough.

) Set value change dial

Changes the boost set value. ORI
g ‘\\“ljl-;lﬂ"}ss
2) Set value numerical display S
Displays the boost as a numerical value. A numerical value cannot Z)Els ) S 3
be input. o )

3) Reset button
Returns to the set value written last.

Boost ON/OFF
Switches between the mode that turns on the boost function only when the servo is
operated at slow speed and the mode that turns on normal boost.

Boost
@ ON
OFF

ON at slow speed (Normally use at this setting.)

Normally ON (When wanting quick operation)

Speed Control

Sets the operating speed. The effect of voltage, load torque, motor, and other changes
can be eliminated and the speeds of multiple servos can be matched.

(Setting range: Max. 0.047 sec/60deg to 12 sec/60deg or none)

However, note that even if set to over the maximum speed of the servo at each
operating voltage, the speed does not become a speed over the maximum speed.

) Set value change dial

4
Changes the speed control set value. ) Speed Control
2) Set value numerical display ~ i '
Displays speed control as a numerical value. A numerical value )3)
cannot be input. 2)[720 Jsec/ st

3) Reset button
Returns to the set value written last.

4) Speed control enable/disable
When checked, speed control setting is enabled.
(The actual servo speed upper limit depends on the performance of each servo.)
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S-Link

Damper factor
The characteristics when the servo stops can be set. (Setting range: 0 to 255)

When smaller than the standard value the characteristic becomes an overshoot (return
after traveling too far) characteristic. When the value is large, the stop setting applies
the brake before the stop position.

Makes it especially difficult for the servo to hunt (phenomena which causes the servo
to oscillator) by suppressing overshoot due to inertia when a large load is applied.
When hunting occurs even though Dead Band, Stretcher, and other parameters are
suitable adjust this parameter to a value larger than the initial value.

Relationship between damping set value and servo operation
Damping small : When you want to overshoot. Set so that hunting does not occur.

Damping large : When you want to operate like braking was applied. However, it feels like the
Servo response is poor.

Note: When used in the state in which hunting occurs not only will the current consumption increase,
but the servo life will also be shortened.

l) Set value change dial
Changes the damping gain set value.

Damper factor
2) Set value numerical display :\\HZII_)”J”,
Displays the damping gain as a numerical value. A numerical value '
cannot be input. TR
3) Reset button 2)[w ] 3

Returns to the set value written last.

Stretcher gain
The servo hold characteristic can be set. (Setting range: x0.125 to x8)

When the current servo position deviates from the target position the torque which
attempt to return the servo to the target position can be adjusted. This is used to stop
hunting, etc., but the hold characteristic changes as shown below.

Relationship between stretcher set value and servo operation
Stretcher small : Servo holding force weak
Stretcher large : Servo holding force strong

Note: When the stretcher is large, the current consumption increases.

) Set value change dial
Changes the stretcher gain set value.

x0.5%0. B7x1.5

. X "“' o xB

2) Set value numerical display i Q‘ 1) "0!
Displays the stretcher gain as a numerical value. A numerical value 2) ;\ f’.

cannot be input. . - 3)

Stretcher gain

3) Reset button
Returns to the set value written last.
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Soft Start
Restricts operation in the specified direction the instant the power is turned on. By
making this setting, only the first operation when the power is turned on slowly moves
the servo to the specified position.

(Setting range: 0.8 sec/60deg to 12 secs/60deg or none)

I) Set value change dial

Changes the soft start delay set value. ‘P&,ﬂ -

LR}

2) Set value numerical display > A0
Displays the soft start delay as a numerical value. A numerical value 2, ~‘_J3)
cannot be input. 2) (30 Jsecrs

3) Reset button
Returns to the set value written last.

4) Soft start delay enable/disable
When checked soft start display setting is enabled.

The direction of rotation of the servo can be changed. © Nermal

Servo reverse (normal/reverse) -
() Reverse “

When you want the servo to rotate in the direction opposite the
standard direction, set to "Reverse".

Stop Mode (Free/Hold)
The state of the servo when the servo input signal was disrupted can be specified.

However, when "Free" the servo becomes weak and when "Hold" Stop Mode

the angle immediately before the signal was disrupted is held. 0::: |
The servo hold mode can be set even with AM and FM systems.

However, there is no fail safe function.

Buzzer (ON/OFF)

When alarm was set to ON when the servo power was turned on first without the transmitter
emitting radio waves the servo continues to emit a buzzer sound 2.5 times/second.

(Even when transmitter radio waves are output first, the buzzer sounds until the servo

signal is output normally, but this is normal.)

Buzzer
When the transmitter power was turned off first at the end of © 0N |

operation, the buzzer sounds 1.25 times/second as an alarm that ® OFF
you forgot to turn off the servo power.
However, this may not occur depending on the type of servo.

(If the servo connector is disconnected while the receiver power is on, since an S-BUS
connected servo will be erroneously recognized and a confirmation sound may be
generated, do not disconnect the connector while the power is on.)

Note: Since a buzzer sound is generated by oscillating the servo motor and current is consumed and heat
is generated, do not operate more than necessary or continue to sound the buzzer for a long time.
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S-Link

Smoothe (ON/OFF)

This function makes servo operation smooth. Set it according to your taste. Normally
set it to ON. Set it to OFF when want especially quick operation.

Smoather
) ON
@ OFF

When the smoother function was set to ON and the servo was
operated the distance up to the target position is changed in steps
SO movement is smooth.

Write button
When the parameters on the S-Link main screen are changed, the
servo parameters are temporarily changed and when the power is | Wi | ||
turned off they return to their value before the change. Therefore, to
record the changed parameters at the servo, click the "Write" button.

Default button
The "Default" button returns the servo parameters to their factory settings.

*"Default" requires a valid ID. When the ID is automatically

recognized by independent servo setting click the "Disconnect" | Defeult | ”
button to disconnect the S.Link program and servo. After ticking

the check box at the left side of "ID Enable" and reconnecting the

program and servo with the "Connect" button, execute "Default".

*Tool menu

The Tool menu has "Language" and "Settings" functions, in addition to the "Connect",
“Disconnect”, "Write", and "Default" functions described up to here.

"Language"

This function allows you to select the S-Link Program display language from among English,
Japanese, and Deutsch.

-
[ s-Link 1.001 —
File(F) | Tool(T) | Help(H)
Connec t
SBUS2
Disconnect 0 40 0 g - [[] ID Enable ~
: Wi 4 il b = OlL-2 Serva
- *

el
’ g SBUSCH [ 01 | [ Ghanee | ® 0
)

Dead Band = ‘

Connect
O ‘,

= e Disconnect

Default @& N

Language  » |[w]| English

T ]| lapanese

Deutsch

e

=z ” 45
aseg o 1520 [2] 5 Wite
- o = _u ——— == — = __Default
Servo Position

’

[ @20 | [ 1220 ][ 1520 | [ 1820 | [ 2120 |
Travel ajust Damper factar

Reverze
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"Settings"

S-Link

When "Settings" in the "Tools" menu is clicked, the screen shown below appears.

*When the

[l 5-Link 1.001 [E=RETNL =
File{F) | Teool(T) | Help(H)
Connect T G S sBUS2
= L]
5 Disconnect 0 20 To007
i GCIU-2  Serva
Write .
Language Pede Hand Connect
o LR % 1
. & < i
& g = S
& _ /’,’ ‘\\\
1520 ‘ s R
Servo Pogition
[ 920 ][ 1220 ] [1620 ) [L1s20 ) (L2120 ]
Reverse
Travel ajust Damper factor i ‘
Lett Rizht 125 18y @ Morma
v 5 el %0, 87 x1. 6§ Y 1BY Vi
) ! ~ ¢ SNELD e T USRI A 1 | | [ 7 a0  Revarca

"When ending, data on display is not saved." check box is unticked before
starting the parameters data at the end of the last session is displayed.

*When the "S.BUS2 channel is not displayed." check box is ticked, the S-BUS2 system
dedicated CH display at the S.BUS CH (channel) setup window described on P16 is hidden.

Mow setting ...

‘hen ending, data on dizplay iz not saved.

[[] S BUS2 channel is nat displayed.

Cancel

I

Apply

After changing the setting, close the window by clicking "Apply".

*Help menu

There is "S-Link Help" and "About" in the help menu.

"S-Link Help" displays a description of the parameter functions.

"About" displays the S-Link program version and a link to the Futaba website.
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-l
Heutralert
iyt ., 55U O (01 (Grms ®
\\ - Dead Band ~
= = i Gannect
| - # 2
dee Anele(dee) g = -
3 = ’,}‘ \“‘
1520 [T e - i
0
Servo Position
820 ][ 1220 ] [ 1520 ] [.1820 ) [ 2120 ]
Reverse
Travel ajust Damper factor & .
Left Right . ©® Narma
il Al by e %0, 87 x1.5 125 18% Vi
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